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※ 使用されたソースコードはhttp://www.csun.co.jp/からダ

ウンロードできます。 

※ この文書の情報は、事前の通知なく変更されることがあり

ます。 

※ (株)日昇テクノロジーの書面による許可のない複製は、い

かなる形態においても厳重に禁じられています。 
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第一章 MINI2440 ボードの概要 

1.1 仕様 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

※ 液晶は 3.3V/5V 二種類があります。MINI2440 の電圧選択ジャンパ

ー(J2)は必ず正しく設定されなければなりません。 
 
CPU プロセッサー  

• ARM920Tコアを採用したサムソン(SAMSUNG)社のS3C2440A、周波数 400MHz、
最高周波数 533MHz。 

SD/MMC 

GPIO 
34pin 

AD 
test 

User 
LED 

USB 
Host 

LCD I/F CMOS Camera Switch Reset 

DC5V 
2.1mm 

COM0 

10M/100M 
RJ45 

USB 
Slave 

Audio 
Out 

JTAG 
Bus 

44pin 
User 

button 
Nor/Nand 
Select S2 

COM1 

COM2 

MIC 

User 
Button 

Line Audio 
In 

LCD 3.3/5V J2 
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メモリ  

• 64MB SDRAM, 32 ビット幅データ・バス, SDRAM の最高周波数 100MHz 
• 64MB NAND Flash メモリ 
• 2MB NOR Flash メモリ 

液晶(LCD)  

• 4 線式抵抗膜方式のタッチパネルのインターフェース 
• 標準の LCD I/F を持って、3.5”から 12.1”までの各種液晶パネル(黒白、STN、TFT、

最高分解能 1024*768)に対応します。 

インターフェース  

• 10M/100MBase-T Ethernet RJ45(DM9000)ｘ1 
• RS232 シリアルポートｘ3 
• USB1.1 ホストｘ1 
• USB1.1 スレーブｘ1 
• MMC/SD メモリカードのソケットｘ1 
• ステレオ・オーディオの出力ｘ1 
• マイクの入力ｘ1 
• 10 ピンの JTAG(2mm DIP ピッチ) 
• ユーザーLEDｘ4 
• ユーザーボタンｘ6 
• PWM 制御の圧電ブザーｘ1 
• 可変抵抗、A/D のテストの為にｘ1 
• I2C バスの AT24C08、I2C バスのテストの為にｘ1 
• 20 ピン CMOS カメラのインターフェース(2mm DIP ピッチ) 
• RTC のバッテリーバックアプ  
• 34 ピン GPIO(2mm DIP ピッチ) 
• 44 ピンのシステムバス(2mm DIP ピッチ) 

搭載した OS  

• Linux2.6.29 + Qtopia2.2.0 
• WindowsCE.NET 5.0 
• uCOSII 

http://www.csun.co.jp/�
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外形寸法  

• 100×100(mm) 突起物は除く 

供給電源  

• 5VDC 電源、プラグ 1.3mmφ、極性はセンタープラス です。 電源ス

イッチと電源指示 LED 付き 

スイッチ S2 はボードの動作モデルを選択します。一つは Nor Flash から起動です。もう一

つは Nand Flash から起動です。この二つの起動モデルでシステムのアドレスが異なります。 

 

 
デフォルトの設定は Nand Flash から Linux を起動します。 

 

http://www.csun.co.jp/�
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1.2 使えるデバイス例 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

USB カメラ

(SPACXX 又は

UVC に対応) 

外付けハードディスク 

USB 無線 LAN 装置 USB マウスとキーボード 

32GB までの

SD/MMC メモリ 
USB HUB 

USB メモリ 

USB シリアルポート 

PL2303 

http://www.csun.co.jp/�


 不可能への挑戦    不可能への挑戦   株式会社日昇テクノロジー        低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  11 

 

7 インチ液 晶 

 
1024X768 VGA 

※ 付属のドライバ以外は、使えない可能性があります。 
 

http://www.csun.co.jp/�
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1.3 付属アプリケーション例 

 
 
 
 
 
 
 
 
 
 
 

第二章 インターフェースの説明 

2.1 電源 

 
 
 
 
 
 
 
 
 
 
 
 
 

Qtopia デス

クトップ 
mpeg 映画 MP3 

displayer 
Web 

ブラウザー 
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2.2 ユーザーボタン 

 

 K1 K2 K3 K3 K4 K5 
割り込み EINT8 EINT11 EINT13 EINT14 EINT15 EINT19 
GPIO GPG0 GPG3 GPG5 GPG6 GPG7 GPG11 
他の機能 なし nSS1 SPIMISO1 SPIMOSI1 SPICLK1 TCLK1 
CON12 CON12.1 CON12.2 CON12.3 CON12.4 CON12.5 CON12.6 

※ CON12.7 は 3.3V 電源、CON12.8 は GND です。 

2.3 シリアルポート 
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2.4 液晶 LCD インターフェース 

 
LCD インターフェースは最大 RGB(888)の液晶をサポートします。37,38,39,40 ピンは四線

抵抗式のタッチパネルの入力です。J2 は液晶給電の選択、5V 又は 3.3V の液晶に対応しま

す。 
 
2.5 JTAG 
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2.6 GPIO 

 
CON4 名前 説明 CON4 名前 説明 
1 VDD5V 5V 電源 2 VDD33V 3.3V 出力 
3 GND GND 4 nRESET リセット出力 
5 ANI0 AD ch0 6 AIN1 AD ch1 
7 ANI2 AD ch2 8 AIN3 AD ch3 
9 EINT0 EINT0/GPF0 10 EINT1 EINT1/GPF1 
11 EINT2 EINT2/GPF2 12 EINT3 EINT3/GPF3 
13 EINT4 EINT4/GPF4 14 EINT5 EINT5/GPF5 
15 EINT6 EINT6/GPF6 16 EINT8 EINT8/GPG0 
17 EINT9 EINT9/GPG1 18 EINT11 EINT11/GPG3/nSS1 
19 EINT13 EINT13/GPG5/SPIMISO1 20 EINT14 EINT14/GPG6/SPIMOSI1 
21 EINT15 EINT15/GPG7/SPICLK1 22 EINT17 EINT17/GPG9/nRST1 
23 EINT18 EINT18/GPG10/nCTS1 24 EINT19 EINT19/GPG11 
25 SPIMISO SPIMISO /GPE11 26 SPIMOSI SPIMOSI /EINT14/GPG6 
27 SPICLK SPICLK /GPE13 28 nSS_SPI nSS_SPI /EINT10/GPG2 
29 I2CSCL I2CSCL/GPE14 30 I2CSDA I2CSDA/GPE15 
31 GPB0 TOUT0/ GPB0 32 GPB1 TOUT1/ GPB1 
33 CLKOUT0 CLKOUT0/GPH9 34 CLKOUT1 CLKOUT1/GPH10 
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2.7 CMOS CAMERA 

 
CAMERA 名前 他の機能 CAMERA 名前 他の機能 
1 I2CSDA GPE15 2 I2CSCL GPE14 
3 EINT20 GPG12 4 CAMRST GPJ12 
5 CAMCLK GPJ11 6 CAM_HREF GPJ10 
7 CAM_VSYNC GPJ9 8 CAM_PCLK GPJ8 
9 CAMDATA7 GPJ7 10 CAMDATA6 GPJ6 
11 CAMDATA5 GPJ5 12 CAMDATA4 GPJ4 
13 CAMDATA3 GPJ3 14 CAMDATA2 GPJ2 
15 CAMDATA1 GPJ1 16 CAMDATA0 GPJ0 
17 VDD33V 3.3V 電源 18 VDD_CAM VDD_CAM 
19 VDD18V 1.8V 電源 20 GND GND 
 

http://www.csun.co.jp/�
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2.8 システムバス 

 

CON5 名前 説明 CON5 名前 説明 
1 VDD5V 5V 電源 2 GND GND 
3 EINT17 割り込み 17 4 EINT18 割り込み 18 
5 EINT3 割り込み 3 6 EINT9 割り込み 9 
7 nGCS1 0x08000000 8 nGCS2 0x10000000 

9 nGCS3 0x18000000 10 nGCS5 0x28000000 

11 LnOE  12 LnWE  
13 nWAIT  14 nRESET  
15 nXDACK0  16 nXDREQ0  
17 LADDR0  18 LADDR1  
19 LADDR2  20 LADDR3  
21 LADDR4  22 LADDR5  
23 LADDR6  24 LADDR24  
25 LDATA0  26 DATA1  
27 LDATA2  28 DATA3  
29 LDATA4  30 DATA5  
31 LDATA6  32 DATA7  
33 LDATA8  34 DATA9  

http://www.csun.co.jp/�
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35 LDATA10  36 DATA11  
37 LDATA12  38 DATA13  
39 LDATA14  40 DATA115  

2.9 リセット 

 
 
2.10 AD 
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2.11 PWM ブザー 
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第三章 初体験(GUI) 

3.1 タッチパネルの校正 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

GUI システムを再インストールした後、自動的にタッチパネルの校正画面が出てきます。

ペンで“十”字の中心をタッチします。四角と中心、すべて五つの“十”字が順番に出て

きます。タッチパネルがずれた場合は、マウスで設定タブのリカリブレートを選択して、

校正画面も出てきます。 

3.2 日本語の設定 
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“友善之臂”タブの“语言设置”をクリックして、“Japanese”を選択し、「OK」ボタンを

押します。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

「Yes」ボタンを押すと、日本語の画面が出てきますが、フォントの原因なので、ある文字

が表示できません。“口定”タブの“外口”をクリックして、 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
「Font」タブで「Unifont」を選択して、右上の「OK」ボタンを押します。綺麗な日本語

の画面が出てきます。 
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3.3 MP3 の再生 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
「アプリケーション」タブの「ミュージック」を選

択し、自動的に「ドキュメント」の MP3 ファイル

をさがします。探した MP3 をチェックして、再生

ボタンを押します。 
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3.4 ビデオの再生 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
「アプリケーション」タブの「ビデオ」を選択し、

自動的に「ドキュメント」のビデオファイルを探し

ます。探したビデオをチェックして、再生ボタンを

押します。 
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3.5 ピクチャのビューと編集 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
「アプリケーション」タブの「ピクチャ」を選択し、

自動的に「ドキュメント」のピクチャを探します。

探したビデオをクリックして、ビューと編集できま

す。 
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3.6 SD と USB メモリの自動認識 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

SDカードあるいは USBメモリを ARM9ボードに

挿入すると、システムは自動的に SD/USB メモリ

を認識して、アイコンが出てきます。「アプリケー

ション」タブの「システム情報」をクリックして、

「Storage」タブを選択すると、SD/USB メモリの

情報を表示します。 
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3.7 ターミナル 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
「アプリケーション」タブの「ターミナル」をクリックします。パソコンがなくでも、タ

ーミナルでコマンドを入力できます。 

 
ターミナルでほかのシステム(ARM7TDMI/LPC2148)を通信する様子。 
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3.8 ネットワークの設定 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
「FriendlyARM」タブの「ネットワーク設定」を選択して、ネットワークを設定きます。 
 
3.9 ping 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
「FriendlyARM」タブの「ネットワーク設定」を選択して、ping をします。 
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3.10 LED テスト 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
「FriendlyARM」タブの「LEDs」を選択して、

LED の点灯制御ができます。起動した後、「Stop 
led-player」ボタンを押します。 
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3.11 EEPROM テスト 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

書き込みし

たい内容を

入力します。 

このボタン

を押すと、

EEPROM
に書き込む。 

書き込み進度。 

このボタンを押す

と、EEPROM か

らリードする。 

読み込み進度。 

読み込んだ

内容 
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3.12 PWM ブザー 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

音声の周波数が

変更できます。 
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3.13 音声のレコーダー 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

録音 

停止 再生 
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3.14 USB カメラ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

※ Linux-2.6.29はUVCと gspacクラスのUSBカメラをサポートしま

す。 

3.15 CMOS イメージセンサー 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

※ OV9650 をサポートします。 
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3.16 AD テスト 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
ARM9 ボードの可変抵抗を回ると、AD の数値が変化します。 

3.17 ボタン 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ADの数値 
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3.18 手書き 
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3.19 Watch dog 
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3.20 回転 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
ほしい方向を選択して、「OK」ボタンを押します。

システムの再起動が必要かもしれません。 
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3.21 スタートアップ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
起動の時、アプリケーションを自動的に実行させ

ます。Windows のスタートアップにみたい機能で

す。 
 
例は起動の時、時計を自動的に実行させます。 
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3.22 USB GPS 
 

 

秋月電子が販売している USB GPS 
 
秋月電子が販売している GPS USB Dongle 
(GT-730F)は PL2303 という USB シリアルチップ

を使用しているので、ARM9 はこのような USB 
GPS を直接に使えます。 
 
「Serial」というアプリケーションを選択します。 
シリアルの設定： 
ポート：        ttyUSB0 
ボーレート：    38400 
 
 
 
ARM９と GPS が一緒に動く様子 
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第四章 初体験(コンソール) 

• DB9 メス-メス型のストレートケーブルで mini2240 とパソコンを繋ぐ。 

 

 

 

• クロス LAN ケーブルで mini2240 とパソコンを繋ぐ。 
• mini2240 のオーディオ出力とスピーカーを繋ぐ。 

• 5V 電源、極性はセンタープラス です。 

4.1 パソコン側のハイパーターミナルの設定  

パソコンのメニュー：スタート  すべてのプログラム  アクセサリ  通信  ハイ

パーターミナルを選ぶと、次の画面が出てきます。 

 
 
このハイパーターミナルの名前を入力して、"OK"ボタンを押すと。 
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使用したいシリアルポートを選んでください。 
 

 
 
シリアル通信速度を 115200bps に設定します。フロー制御はなしです。 
"OK"ボタンを押すと、設定が完了します。 
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4.2 MP3 の再生 

コマンド madplay 
ソースコード madplay.tgz 
コンパイル Arm-linux-gcc-4.3.2 with EABI 
# madplay your.mp3 
このコマンドは your.mp3 というファイルを再生します。自分で your.mp3 ファイルを用意

してください。「Ctrl+c」で停止させます。 
 

4.3 USB メモリと外付けハードデスク 

USB メモリを USB ホスト又は USB ハブに挿入すると 

 
自動的にこのような情報が出てきます。USB メモリのデバイス名は/dev/udisk です。シス

テムは自動的に/udisk にマウントします。 
※ FAT32/VFAT だけの USB メモリが認識できます。 
 

/udisk に移動して、USB メモリのファイルをリストします。 
# cd /udisk 
# ls 
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4.4 SD/MMC カード 
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SD/MMC カードを ARM9 に挿入すると、この情報が出てきます。システムは自動的に

/sdcard フォルダを生成します。 

 

/sdcard フォルダのファイルをリストします。 
# ls /sdcard 
 

4.5 シリアルポートでファイルを ARM9 にダウンロード 

 
「転送」「ファイルの送信」を選択、 
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送信したいファイルを選んで、「送信」ボタンを押します。 

 
 

 
転送が正しいかどうか、md5sum コマンドで検証します。 
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4.6 シリアルポートで ARM9 のファイルを PC に保存 

 

 
保存先を設定して、「閉じる」ボタンを押します。 
# sz PRODUCTS.GIF 
コマンドで転送が開始します。 
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4.7 LED 制御 

コマンド led-player leds 
ソースコード led-player.c leds.c 
パッケージ examples.tgz 
コンパイル Arm-linux-gcc-4.3.2 with EABI 
デバイス名 /dev/leds 
ドライバ Linux-2.6.29/drivers/char/mini2440_leds.c 
1) LED サーバ 
システム起動の時、自動的に LEDサーバ(led-player)を起動させます(/etc/rc.d/init.d/leds)。
LED を点滅させています。led-player を実行した後、/tmp/led-control というパイプを生成しま

す。 
#echo 0 0.2 > /tmp/led-control 
LED が 0.2 秒周期で流れます。 
 
#echo 1 0.2 >/tmp/led-control 
LED が 0.2 秒周期で累計します。 
 
#/etc/rc.d/init.d/leds stop 
LED を停止します。 
 
#/etc/rc.d/init.d/leds start 
LED が点滅をスタートします。 
 
2) 単独 LED 制御 
#/etc/rc.d/init.d/leds stop 
LED サーバをストップさせます。 
 
# led 
Usage: leds led_no 0|1 
led_no は LED 番号(0,1,2,3)です。 
 
#led 2 1 
LED2 を点灯させます。 
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4.8 ボタンのテスト 

コマンド buttons 
ソースコード buttons_test.c 
パッケージ examples.tgz 
コンパイル Arm-linux-gcc-4.3.2 with EABI 
デバイス名 /dev/buttons 
ドライバ Linux-2.6.29/drivers/char/mini2440_buttons.c 

 
#buttons 
このコマンドを入力してください。 
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4.9 シリアルポートのテスト 

コマンド armcomtest 
ソースコード Comtest.c 
パッケージ examples.tgz 
コンパイル Arm-linux-gcc-4.3.2 with EABI 
デバイス名 /dev/ttySAC0,1,2   或は 

/dev/ttyUSB0,1,2   或は 
/dev/ttyACM0,1,2 

※ ARM9 は自分の三つのシリアルポートが/dev/ttySAC0,1,2 です。 
※ ARM9 は弊社が販売している USB-RS232 変換ケーブルを直接使え

ます。デバイス名は/dev/ttyUSB0,1,2 です。 
※ ARM9 は弊社が販売している ARM7TDMI/LPC2148 を USB で通

信 で き ま す 。 ARM7TDMI/LPC2148 の デ バ イ ス 名 は

/dev/ttyACM0,1,2 です。 
このコマンドは LPC2148 と通信します。 
#armcomtest –d /dev/ttyACM0 -o 
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4.10 ブザー(PWM)のテスト 

コマンド pwm_tset 
ソースコード pwm_tset.c 
パッケージ examples.tgz 
コンパイル Arm-linux-gcc-4.3.2 with EABI 
デバイス名 /dev/pwm 
ドライバ Linux-2.6.29/drivers/char/pwm.c 
#pwm_test 

 

“+”と”-”キーは音声の周波数を変更させます。”ESC”キーは音声を停止させます。 
 

4.11 LCD のバックライト 

#echo 0 > /dev/backlight  ;バックライト消灯 
#echo 1 > /dev/backlight  ;バックライト点灯 
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4.12 I2C-EEPROM 
コマンド i2c 
ソースコード eeprom.c 24cXX.c 
パッケージ examples.tgz 
コンパイル Arm-linux-gcc-4.3.2 with EABI 
デバイス名 /dev/i2c/0 
ドライバ Linux-2.6.29/drivers/i2c/busses/i2c-s3c2440.c 
 
#i2c –w  ;データ(0~255)をボードの 24C08 に書き込む 
#i2c –r  ;ボードの 24C08 からデータを読み出す 
 

4.13 AD テスト 

コマンド adc-test 
ソースコード adc-test.c 
パッケージ examples.tgz 
コンパイル Arm-linux-gcc-4.3.2 with EABI 
デバイス名 /dev/adc 
ドライバ Linux-2.6.29/drivers/char/mini2440_adc.c 
 
#adc-test 
ボードの可変抵抗をまわして、AD 数値の変化が見えます。 
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4.14 CMOS イメージセンサー 

コマンド camtest 
ソースコード camtest.c 
パッケージ examples.tgz 
コンパイル Arm-linux-gcc-4.3.2 with EABI 
デバイス名 /dev/camera 
ドライバ Linux-2.6.29/drivers/media/video/s3c2440camif.c 
 
#camtest 

 
 

4.15 ネットワーク機能 

4.15.1 ウェブサーバー 
Linux でウェブサーバー (boa)をインストールしました。パソコンのブラウザーで

http://192.168.1.230 を入力すると、mini2440 のホームページが見えます。このホームペ

ージを通じて、ユーザーLED と USB カメラ(*)をアクセスできます。 
※ mjpg-streamer というソフトウェアをインストールすることが必要

です。 
 

 

CMOS イメー

ジ セ ン サ ー

(OV9650)。 
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4.15.2 Telnet と Ftp 機能 
Linux でクライント側とサーバー側の Telnet/Ftp をインストールしました。ご利用してく

ださい。 
デフォルトの設定： 
Telnet のユーザーネームは root です、password がありません。 
Ftp のユーザーネームは plg です、password も plg です。 
 
4.15.3 DNS と gateway の設定 
DNS の IP アドレスを/etc/resolv.conf ファイルに書き込みます。 
gateway の設定：#route add default gw 192.168.1.1 
 
4.15.4 MAC アドレスの設定 
# ifconfig eth0 down 
# ifconfig eth0 hw ether 00:11:AA:BB:CC:DD(新 MAC アドレス) 
# ifconfig eth0 up 
新 MAC アドレスが有効のため、これらのコマンドを起動スクリプト/etc/init.d/rcS に書き

込みます。 
 
4.15.5 ネットワーク・ファイルシステム(NFS)のマウント 
まず、ネットワーク・ファイルシステムのサーバーを構築します。 
#mount –t nfs –o nolock 192.168.1.111:/root_nfs /mnt 
192.168.1.111 はネットワーク・ファイルシステムのサーバーの IP アドレスです。 
マウント成功すれば、ARM9 は大きなリモート・ハードディスク(/mnt)を直接にアクセス

できます。プログラムを開発する時が便利です。 
#umount /mnt #リモート・ハードディスクを ARM9 システムから外します。 
 

4.16. RTC の設定 

(1)#date -s 042916352007 #今の時間を設定します：2007-04-29 16:34 
(2)#hwclock -w #今の時間を S3C2440 の RTC に保存します。 
(3)#hwclock -s #起動の時、Linux 時間を S3C2440 の RTC から回復します。 

※ hwclock -s コマンドは起動スクリプト(/etc/init.d/rcS)に書き込みま

した。起動の時、自動的に実行します。 
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4.17 液晶(LCD)画面を取ります 

#snapshot pic.png 
液晶(LCD)で表示された画面を pic.png というファイルに保存します。 
 

4.18 USB 無線 LAN 

Linux-2.6.29には rt73という USB無線 LANのドライバを実装しました。この類型のUSB
無線 LAN を ARM9 ボードの USB ホストに挿入すると、次の情報が出てきます。 
[root@FriendlyARM /]# usb 1-1: new full speed USB device using s3c2410-ohci and 
address 2 
usb 1-1: New USB device found, idVendor=148f, idProduct=2573 
usb 1-1: New USB device strings: Mfr=1, Product=2, SerialNumber=0 
usb 1-1: Product: 54M.USB....... 
usb 1-1: Manufacturer: Ralink 
usb 1-1: configuration #1 chosen from 1 choice 
wmaster0 (rt73usb): not using net_device_ops yet 
wlan0 (rt73usb): not using net_device_ops yet 
 
[root@FriendlyARM /]# ifconfig eth0 down 有線 LAN をストップ 
[root@FriendlyARM /]# ifconfig wlan0 up 無線 LAN を起動 
rt73usb 1-1:1.0: firmware: requesting rt73.bin 
利用可能の無線ネットを探す 
[root@FriendlyARM /]# iwlist scanning | grep ESSID  
lo Interface doesn't support scanning. 
eth0 Interface doesn't support scanning. 
wmaster0 Interface doesn't support scanning. 
ESSID:"FRIENDLY-ARM" 
ESSID:"NETGEAR" 
ESSID:"TP-LINK"  
 
無線ネットの ESSID を入力 
[root@FriendlyARM /]# iwconfig wlan0 essid "FRIENDLY-ARM" 
 
無線ネットのパスワードを入力 
[root@FriendlyARM /]# iwconfig wlan0 key s:12345 
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無線ネットのルータに接続 
[root@FriendlyARM /]# iwconfig wlan0 ap auto 
 
IP アドレスの設定 
[root@FriendlyARM /]# ifconfig wlan0 192.168.1.120 
 
無線ネットのテスト 
[root@FriendlyARM /]# ping 192.168.1.1 
PING 192.168.1.1 (192.168.1.1): 56 data bytes 
64 bytes from 192.168.1.1: seq=0 ttl=64 time=42.804 ms 
64 bytes from 192.168.1.1: seq=1 ttl=64 time=5.020 ms 
64 bytes from 192.168.1.1: seq=2 ttl=64 time=5.021 ms 
^C 
--- 192.168.1.1 ping statistics --- 
3 packets transmitted, 3 packets received, 0% packet loss 
round-trip min/avg/max = 5.020/17.615/42.804 ms 
[root@FriendlyARM /]# 
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第五章 Linux のクロス開発環境 

5.1 クロス開発環境を構築 

ARM9 のクロス開発環境は Fedora9/11 をお勧めします。 
 
Fedora で ARM のクロス開発ツールをインストールします。 
$ su  スーパーユーザーに切り替え 
# tar xvzf arm-linux-gcc-4.3.2.tgz -C / 

※ 使いやすいため、「export PATH=$PATH:/usr/local/arm/3.4.1/bin」
を.bashrc ファイルに入れます。 

$ vi ~/.bashrc 
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再び Fedora のターミナルを開き、次のコマンド： 
$ arm-linux-gcc –v 

 

この画面が出たら、ARM 用のクロス開発環境をインストール成功しました。 
 

5.2 NFS サーバーを構築 

ネットワーク・ファイルシステム(NFS)を使用すれば、ARM9 は大きなホストのハードディ

スクを直接にアクセスできます。プログラムを開発する時が便利です。次は NFS サーバー

を構築手順です。 
 
(1) NFS のルートシステムファイルを解凍します。 

# tar xvzf root_qtopia.tgz -C / 

 

(2) /etc/exports ファイルを編集します。 

「/ root_qtopia *(rw,sync,no_root_squash)」を/etc/exportsというファイルに入れま

す。 
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(3) NFS サーバを起動します。 
# /etc/init.d/nfs start 
 
(4) NFSf ファイルシステムを確認します。 
# mount -t nfs localhost:/root_nfs /mnt/ 
# ls /mnt 
 
※ firewall の設定によって、外部から NFS へアクセスできない可能性があります。 

5.3 NFS はルートファイルシステムとして起動 

ARM9 ボードが起動、又はリセットの時、ハイパーターミナルにスペースキーを押します。

次のコマンドを入力します。 
Supervivi>param set linux_cmd_line "console=ttySAC0 root=/dev/nfs 
nfsroot=192.168.1.111:/root_nfs 
ip=192.168.1.70:192.168.1.111:192.168.1.111:255.255.255.0:MINI2440.arm9.
net:eth0:off" 
param set linux_cmd_line は linux 起動のパラメーターです。パラメーターの意味は： 
nfsroot は NFS サーバーの IP アドレス。 
“ip=”の後ろ： 
第一項(192.168.1.70)は ARM9 ボードの IP； 
第二項(192.168.1.111)はホストの IP； 
第三項(192.168.1.111)はゲットウェイの IP； 
第四項(255.255.255.0)はネットマスク； 
第五項はホストのドメイン(自由的に入力でも大丈夫です) 
eth0 は LAN デバイスの名前。 
 
Boot コマンドを入力すると 
Supervivi>boot 
 
ARM9 ボードは NFS からブートします。 
 

第六章 Linux 環境のアプリケーションを開発 
6.1 Hello, World! 
Hello, World のソースコードは examples.tgz にあります。 
#include <stdio.h> 
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int main(void) { 

printf("hello, FriendlyARM!¥n"); 

} 

6.2 Hello,World をコンパイル 

#cd examples/hello 
#arm-linux-gcc –o hello main.c 
又は 

#make 
実行できるhelloを生成します。 

 

6.3 Hello,World を ARM9 ボードで実行 

生成された実行コードhelloをARM9ボードに入れて、ARM9のコンソールで実行し

ます。 

# ./hello 

hello, FriendlyARM! 

 

ARM9ボードに入れるのは幾つの方法があります。USB・SDメモリ、シリアルポー

ト、FTPなど。一番便利な方法はNFSです。ARM9ボードは直接にホスト側の実行

ファイルを実行できます。 

 

6.4 ほかのサンプル 

examples.tgzに幾つのサンプルがあります。 
adc-test  ADCテスト 
buttons  ボタンテスト 
c++  C++サンプル 
camtest  CMOSイメージセンサーテスト 
comtest  シリアルポートテスト 
hello 
i2c  i2c EEPROMテスト 
led-player pipeサンプル 
leds  LED点灯 
math  数学処理 
pthread  スレッド 
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pwm  PWMテスト 
udptalk  UDP通信サンプル 
 

6.5 Qt/Embedded GUI プログラムを作る 

詳細の QT 組込開発手順は「QT-Embedded_DEV_manual.pdf」を参照 
# tar zxvf arm-qtopia-2.2.0.tar.gz -C /opt/FriendlyARM/mini2440 
Qtopia-2.2.0 のパッケージをディレクトリ/opt/FriendlyARM/mini2440 に展開します。 

# cd /opt/FriendlyARM/mini2440/arm-qtopia 
# ./build-all 長い時間がかかりますので、我慢してください 
#./mktarget ターゲットに書き込むファイル target-qtopia-konq.tgz を生成 

サンプル hello をコンパイルします 
# cd /opt/FriendlyARM/mini2440/arm-qtopia/hello 

# ./build 
 

コンパイル完了すれば、ディレクトリ arm-qtopia/qtopia-2.2.0-FriendlyARM/qtopia/bin に実

行ファイル hello を生成させます。実行ファイル hello と arm-qtopia/hello/hello.desktop
を ARM9 ボードにダウンロードして、ARM9 の適当なディレクトリに移転します。 

#chmod +x hello 
#mv hello /opt/Qtopia/bin 
#mv hello.desktop /opt/Qtopia/apps/Applications 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

再起動すれば、デスクトップで hello のアイコンが見えます。実行させると… 
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第七章 Linux カーネルを再構築 

7.1 カーネルのソースコードを解凍 

$ tar xvzf linux-2.6.29-mini2440-20090609.tgz 
※ このカーネルはQQ2440v3/MINI2440に両対応する 
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7.2 Linux を再コンパイル 

$ cd linux-2.6.29 
$ ls  ファイルをリストします 

 
config_mini2440_xxxはmini/micro2440用コンフィグファイルです。 

config_qq2440_xxxはmini2440用コンフィグファイルです。 

 

a70は7インチ用コンフィグファイルです。 

n35は3.5インチ用コンフィグファイルです。 

vga1024X768はVGA用コンフィグファイルです。 
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$ cp config_mini2440_n35 .config あるコンフィグファイルを選択します 
$ make menuconfig 
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何も変更しません、「Exit」を選択します。 

 

この画面が出てきたら、「Yes」を押します。make zImageでコンパイルします。 
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コンパイル完了すると、arch/arm/bootフォルダにLinuxのカーネルzImageを生成さ

せます。 

 

7.3 ドライバの場所 

(1)DM9000 10/1000Mイーサネット 
Linux-2.6.29/drivers/net/dm9000.c 

(2)シリアルポート(三つのシリアルポート0,1,2，デバイス名/dev/ttySAC0,1,2) 
Linux-2.6.29/drivers/serial/s3c2440.c 

(3)リアルタイマーRTC 
Linux-2.6.29/drivers/rtc/rtc-s3c.c 

(4)LED 
Linux-2.6.29/drivers/char/mini2440_leds.c 

(5)ボタン 
Linux-2.6.29/drivers/char/mini2440_buttons.c 

(6)タッチパネル 
Linux-2.6.29/drivers/input/touchscreen/s3c2410_ts.c 

(7)yaffs2ファイルシステム 
Linux-2.6.29/fs/yaffs2 

(8)USBマウス、キーボード 
Linux-2.6.29/drivers/usb/hid 
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(9)SD/MMCメモリカード(最大32GB) 
Linux-2.6.29/drivers/mmc 

(10)Nand Flash 
Linux-2.6.29/drivers/mtd/nand 

(11)UDA1341オーディオ 
Linux-2.6.29/sound/soc/s3c24xx 

(12)LCD液晶 
Linux-2.6.29/drivers/video/s3c2410fb.c 

(13)USBメモリ 
Linux-2.6.29/drivers/usb/storage 

(14)gspca類USBカメラ 
Linux-2.6.29/drivers/media/video/gspca 

(15)I2C-EEPROM 
inux-2.6.29/drivers/i2c 

(16)バックライト 
Linux-2.6.29/drivers/video/mini2440_backlight.c 

(17)PWMブザー 
Linux-2.6.29/drivers/char/mini2440_pwm.c 

(18)Watchdog 
Linux-2.6.29/drivers/watchdog/s3c2410_wdt.c 

(19)ADC 
Linux-2.6.29/drivers/char/mini2440_ad.c 

(20)CMOSイメージセンサー 
Linux-2.6.29/drivers/media/video/s3c2440camif.c 

(21)USB無線LAN 
Linux-2.6.29/drivers/net/wireless/rt2x00 

(22)USB-RS232変換ケーブル 
Linux-2.6.29/drivers/usb/serial/pl2302.c 

(23)CDC ACM(ARM7TDMI/LPC2148通信) 
Linux-2.6.29/drivers/usb/class/ 
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7.4 Linux カーネルのコンフィグ 

$ cd linux-2.6.29 
$ cp config_mini2440_n35 .config あるコンフィグファイルを選択します 
$ make menuconfig 

 
初のコンフィグ画面です。 
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7.4.1 LCD 液晶とバックライト 

 
初の画面で「Device Drivers」を選択、 

 
「Enter」キーで「Graphics support」に入ります。 
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「support for frame buffer devices」に入ります。 

 

まず、スペースキーで「Backlight support for FriendlyARM board」に<*>を入れます。「LCD 

select」に入ります。 
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3.5インチのLCDを選択します。コンフィグ完了したら、「Exit」で「Device Drivers」メニ

ューに戻ります。 
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7.4.2 タッチパネル 
「Device Drivers」メニューの「Input device support」に入ります。 

 

 

「Touchscreens」に入ります。 
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画面のように選択します。「Exit」で「Device Drivers」メニューに戻ります。 

 

7.4.3 USB マウスとキーボード 
「Device Drivers」メニューの「HID Devices」に入ります。 
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画面のように選択して、「Exit」で「Device Drivers」メニューに戻ります。 

 

7.4.4 USB メモリ 
「Device Drivers」メニューの「SCSI device support」に入ります。 
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画面のように選択して、「Exit」で「Device Drivers」メニューに戻ります。 

「Device Drivers」メニューの「USB support」に入ります。 

 
「USB Mass Storage support」を選択して、「Exit」で「Device Drivers」メニューに戻ります。 
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7.4.5 汎用 USB カメラ 
「Device Drivers」メニューの「Multimedia devices」に入ります。 

 
「video capture adapters」に入ります。 
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「V4L USB devices」に入ります。 

 

「GSPCA based webcams」に入ります。GSPCAはあるフランス人によって作られた汎用USB

カメラドライバです。たくさん種類のUSBカメラをサポートしますが、USBカメラは微妙な

差がありますので、アプリケーションは区別に処理しなければなりません。 

http://www.csun.co.jp/�
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すべてのUSBカメラを選択して、「Exit」で「Device Drivers」メニューに戻ります。 

 

7.4.6 CMOS イメージセンサー(OV9650) 
「Device Drivers」メニューの「Multimedia devices」に入ります。 
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「OV9650 on the S3C2440 driver」を選択して、「Exit」で「Device Drivers」メニューに戻り

ます。 

※ このドライバはV4L/V4L2ドライバではありません。普通なキャラク

タ・ドライバです。 
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7.4.7 イーサネット 
「Device Drivers」メニューの「Networking support」に入ります。 

 

 

TCP/IPプロトコルを選択して、「Exit」で「Device Drivers」メニューに戻ります。 
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「Device Drivers」メニューの「Network device support」に入ります。 

 

 
「Ethernet(10 or 100Mbit)」に入ります。 
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<*> Generic Media Independent Interface device support 

<*> DM9000 support 

「Exit」で「Device Drivers」メニューに戻ります。 

 

http://www.csun.co.jp/�


 不可能への挑戦    不可能への挑戦   株式会社日昇テクノロジー        低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  81 

7.4.8 USB 無線 LAN 
「Device Drivers」メニューの「Networking support」に入ります。 
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「wireless」に入ります。 

 

画面のように「＊」を選択して、「Exit」で「Device Drivers」メニューに戻ります。 

 
「Device Drivers」メニューの「Network device support」に入ります。 
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「Wireless LAN」に入ります。 

 
「Ralink driver support」に入ります。 
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「Exit」で「Device Drivers」メニューに戻ります。 

7.4.9 オーディオ 
「Device Drivers」メニューの「Sound card support」に入ります。 
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「Exit」で「Device Drivers」メニューに戻ります。 

7.4.10 SD/MMC メモリカード 
「Device Drivers」メニューの「MMC/SD/SDIO card support」に入ります。 
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画面のように「＊」を選択して、「Exit」で「Device Drivers」メニューに戻ります。 

7.4.11 Watchdog 
「Device Drivers」メニューの「Watchdog Timer support」に入ります。 
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「S3C2410 Watchdog」を選択して、「Exit」で「Device Drivers」メニューに戻ります。 

 

7.4.12 LED 
「Device Drivers」メニューの「Character devices - - ->」に入ります。 

 

http://www.csun.co.jp/�


 不可能への挑戦    不可能への挑戦   株式会社日昇テクノロジー        低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  89 

7.4.13 ボタン 
「Device Drivers」メニューの「Character devices - - ->」に入ります。 

 
7.4.14 PWM ブザー 
「Device Drivers」メニューの「Character devices - - ->」に入ります。 
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7.4.15 AD 
「Device Drivers」メニューの「Character devices - - ->」に入ります。 

 

7.4.16 シリアルポート 
「Device Drivers」メニューの「Character devices - - ->」に入ります。 

 

http://www.csun.co.jp/�


 不可能への挑戦    不可能への挑戦   株式会社日昇テクノロジー        低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  91 

「serial driver」に入ります。 

 

7.4.17 リアルタイマーRTC 
「Device Drivers」メニューの「Character devices - - ->」に入ります。 
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「Real Time Clock」に入ります。 
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7.4.18 I2C - EEPROM 
「Device Drivers」メニューの「I2C support」に入ります。 
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7.4.19 yaff2s ファイルシステム 

「Device Drivers」メニューの「Memory Technology Device (MTD) support」に入りま

す。 
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画面のように「＊」を選択します。「NAND Device Support」を探して、入ります。 
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選択して、メインメニューに戻ります。メインメニューで「File systems」を探して、入りま

す。 
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「Miscellaneous filesystems」に入ります。 

 

 
「YAFFS2 file system support」を選択します。「Exit」で「Device Drivers」メニューに戻り

ます。 
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7.4.20 EXT2/VFAT/ NFS ファイルシステム 

NFS： 
「File systems」メニューのNetwork File Systemsに入ります。 

 

 

http://www.csun.co.jp/�


 不可能への挑戦    不可能への挑戦   株式会社日昇テクノロジー        低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  99 

FAT： 
「File systems」メニューの「DOS/FAT/NT Filesystems」に入ります。 
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7.4.21 USB-RS232 シリアルポート 

 
弊社が販売している USB-RS232 変換ケーブル 

 

「Device Drivers」メニューの「USB support」に入ります。 
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「USB Serial Converter support」に入ります。 

 
Prolific 社の PL2303 のドライバを選択します。 
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7.4.22 ARM7TDMI/LPC2148 との通信 
ARM9 は標準 OS に Linux を採用します。Linux には、信頼性が高いネットワークスタッ

クが実装され、利用できます。従って、ネットワークに接続する信頼性の高い遠隔制御機

器が、容易に作成できる利点があります。Linux にも USB スタックが実装され、多種類の

USB デバイスを利用できます。例えば、USB プリンター、USB 無線 LAN、USB メモリ、

SD カードなど。パソコンの Linux 上のアプリケーションが ARM9 上で利用できます。ゼ

ロから開発せずに、例えば Web サーバーなどが組み込み用機器で利用できるわけで、これ

は非常に大きな利点といえます。 
 
Linux の便利さの反面、複雑、重い、反応速度が遅いです。反応速度は大体数十 ms ぐらい

です。この反応速度は人間との会話に満足できますが、機械制御のリアルタイム性に足り

ないかもしれません。 
 
ARM7 シリーズはリアルタイム制御に向けのマイコンです。OS なしあるいは簡単な RTOS
を搭載します。1us~1ms 以上の反応速度が実現できます。LPC2148 は NXP 社によって開

発された ARM7 シリーズのマイコンです。CPU の周波数 60MHz、512KB Flash、42KB 
RAM。14 チャネル 10 ビット AD、1 チャネル 10 ビット DA、6 チャネルの PWM。 
 
その上、LPC2148にはUSBターゲットポートを持ちます。最大通信速度 12Mbps。LPC2148
は USB デバイスとして使えます。ARM9 は USB ハブを経由すれば、何台分の LPC2148
にも接続できます。システムは ARM9/MINI2440 と ARM7/LPC2148 を同時に採用すれば、

Linux の便利な機能と ARM7 のリアルタイム性を組み合わせ、高度複雑なアプリケーショ

ンとリアルタイム制御が両立できるシステムを作れます。 
 
 

 

 

 

 

 

 

 

 

 

 

弊社が販売している LPC2148 開発キットとモジュール 
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ARM9 が ARM7TDMI/LPC2148 を USB で通信する様子 

インターフェース

ボード 

A/D 

DO 

ARM7/LPC2148 

USB ハブを経由す

れば、何台分のイン

ターフェースボー

ドに接続できます。 

D/A 

DI 

USB ハブ 

ARM7/LPC2148 

…… 

…… 
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「Device Drivers」メニューの「USB support」に入ります。 

 
「USB Modem(CDC ACM) support」を選択します。“Exit”&“Save”します。 
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7.5 Linux 起動ロゴを作る 

 
Linux が起動の時、このようなロゴが出てきます。自分で好き

な画像に変換することができます。 
 
ロゴを作るツールを解凍します。 
$ su スーパーユーザーに切り替え 
# tar zxvf logomaker.tgz -C / 
 

コンソールで 
$ logomaker 

 

Logomaker の初の画面です。 
File  Open a picture file…で好きなピクチャを選択します。 
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選択したピクチャが表示されます。File  Convert the picture to a Linux Logo FileでLinux logo

に変換します。linux_logo_clut224.ppmというロゴファイルを生成します。このファイルを

linux-2.6.29/drivers/video/logo にコピーすれば、新ロゴを生成しまします。 

 

7.6 yaffs ルートファイルシステムのイメージを生成 

1. yaffsイメージを生成するツールを解凍します。 
$ su  スーパーユーザーに切り替え 
# tar xvzf mkyaffsimage.tgz -C / 
 

# mkyaffsimage root_qtopia root_qtopia.img 
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7.7 Linux ドライバの開発入門 

Linuxなどの現代的なOSでは、デバイスに対する入出力はデバイスドライバを通じて行うの

が常識です。Linuxは「特権モード」を使い、カーネルモードとユーザーモードを厳密に分

離しています。ユーザーモードからは、物理メモリアドレスやI/Oポートなどへのアクセス

はできません。したがって、デバイスに対する入出力は、カーネルモードで動作するドラ

イバを通じて行うしかないです。 

 

ある例を通じて、カーネルモードで動作するドライバの設計を紹介します。 

 

7.7.1 簡単なドライバのソースコード 
ソースコード：linux-2.6.29/drivers/char/mini2440_hello_module.c 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.7.2 コンフィグファイルを編集します 
linux-2.6.29/drivers/char/Kconfigを開きます。下の内容を添加します(実は、添加完了し

ました、確認してみます)。 

#include <linux/kernel.h> 

#include <linux/module.h> 

static int __init mini2440_hello_module_init(void) 

{ 

printk("Hello, Mini2440 module is installed !¥n"); 

return 0; 

} 

static void __exit mini2440_hello_module_cleanup(void) 

{ 

printk("Good-bye, Mini2440 module was removed!¥n"); 

} 

module_init(mini2440_hello_module_init); 

module_exit(mini2440_hello_module_cleanup); 

MODULE_LICENSE("GPL"); 
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Linux-2.6.29でmake menuconfigを実行して、メニューDevice Drivers   Character 
devicesを選んで、 

 
添加されたものが見えます。spaceキーで「M」を選択します。 
7.7.3 Makefile を編集 
linux-2.6.29/drivers/char/Makefile を開きます。下の内容を添加します(実は、添加完了し

ました、確認してみます)。 
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7.7.4 ドライバをコンパイルします 
linux-2.6.29 で make modules を実行します。linux-2.6.29/drivers/char/でオブジェクトフ

ァイル mini2440_hello_module.ko を生成させます。 

 
 

7.7.5 ARM9 ボードでドライバをインストールします 
mini2440_hello_module.koをARM9にダウンロードロードします。 
#insmod mini2440_hello_module.ko 
 

ドライバを削除します。 
#rmmod mini2440_hello_module.ko 
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第八章 生成されたファイルを書き込む 

8.1 NOR Flash から起動 

ARM9ボードのS2スイッチをNor Flashに設定して、電源を入れて、ARM9ボードはNor 
Flashから起動します。 

 

 

8.2 USB ドライバのインストール 

開発されたOSとプログラムをUSB通じてmini2240にダウンロードします。その為、USB
ケーブルでmini2240のUSBスレーブポートとパ ソコンのUSBポートを繋ぐことが必要で

す。繋ぐと、パソコンは新しいデバイスを発見して、USBドライバをインストールします。 
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USBドライバをインストール完了あと、パソコンのダウンロード・ツールDNW.exeを実行

して、mini2240とパソコンを繋ぐことが確認できます。 

 
 

※ USBドライバはバッグがあります。ARM9ボードが再起動、又はリ

セットの時、ホスト側は死んだかもしれません。その原因で、ARM9
ボードが起動完了した後、USBケーブルでホストを繋ぎます。 

 

8.3 NAND Flash のパーティション 

メニューの中で、機能号[x]を選択して、NAND Flash のパーティション画面が出てきます。 
※ NAND Flash の中にエラーアリアがあるかもしれません。使用の影

響がありません。 
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8.4 ブートロードの書き込み 

メニューの中で、機能号[x]を選択して、NAND Flash のパーティション画面が出てきます。 
パソコンで DNW を実行します。 

 
DNW のタイトルに[USB: OK]があれば、パソコンと ARM9 ボードを USB で繋ぎました。 
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メニューの中で、機能号[v]を選択して、 

 

DNW を待っています。DNW のメニュー「USB Port」「Transmit」を選択して、 
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ブートロード supervivi_mini2440 を選択して、「開く」を押します。 
＊Mini2440 セットの場合：LCD 出荷状態：Toppoly 3.5" LCD 
＊Micro2440 セットの場合：LCD 出荷状態：INNOLUX 7" LCD 

 
 
ブートロードを書き込み完了すると、自動的にメニューに戻ります。 
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8.5 Linux のカーネルの書き込み 

a. メニューの中で、機能号[k]を選択して、 

 

カーネルをダウンロードすることを待っています。 
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b. DNW のメニュー"USB Port  Transmit"を選択して、Linux カーネルファイル

zImage_XXX を選択して、「開く」を押します。 

 
zImage_A70  7 インチ液晶カーネル 
zImage_T35  3.5 インチ液晶カーネル 
zImage_VGA1024X768 VGA カーネル 
 
c. 転送完了したら、自動的にメニューに戻ります。 
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8.6 ルート・ファイルシステムの書き込み 

a. メニューの中で、機能号[y]を選択して、 

ルート・ファイルシステムをダウンロードすることを待っています。 
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b. DNW のメニュー"USB Port  Transmit"を選択して、ルート・ファイルシステム

root_qtopia.img を選択して、「開く」を押します。 

 
c. 転送完了したら、自動的にメニューに戻ります。 
 
電源を切って、mini2440 の起動 S2 を NAND Flash で起動に設定してください。再び電源

を入れて、NAND Flash で書き込み済みの Linux は起動します。 
 

8.7 NAND Flash のバックアップ 

※ 新ブートロード supervivi のみ 
メニューの中で、機能号[u]を選択して、 
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DNW のメニュー「Usb Port」「Backup NandFlash to File」を選択します。 

 
バックアップのファイルの名前「backup.bin」を入力して 
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バックアップ完了したら、次の画面： 
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生成されたバックアップファイルの大きさは 66MB ぐらいです。 
 

8.8 NAND Flash のリストア 

※ 新ブートロード supervivi のみ 
メニューの中で、機能号[r]を選択して、 
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DNW のメニュー「Usb Port」「Transmit/Restore」を選択します。 

 

バックアップされたファイル「backup.bin」を選択します。 
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8.9 メモリで Linux カーネルを直接に実行 

一般的に Linux のカーネルを NAND Flash に書き込み、実行させます。毎回 Linux カー

ネルを更新すれば、NAND Flash も更新することが必要です。デバッグの時、不便です。

ブートロード Suppervivi は Linux カーネルをメモリにロードして、直接に実行します。 
 
1. 電源を切って、mini2440 の起動 S2 を Nor Flash で起動に設定してください。再び電

源を入れて、Nor Flash で起動します。 
2. Supervivi のメニューの中で、機能号[z]を選択して、 
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3. DNW のメニュー"USB Port  Transmit"を選択して、カーネルファイル zImage を転

送します 
4. 転送完了したら、自動的に Supervivi のメニューに戻ります。機能号[g]を選択して、

linux カーネルを実行させます。この画面が出たら： 
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ルートファイルシステムが見つかりませんでした！ 
 

Supervivi のメニューの中で、機能号[y]を選択して、NAND Flash に root_default.img を

書き込みます。ルートファイルシステムを作ります。又は、NFS をルートファイルシス

テムとして指定します。 
 

Linux カーネルを実行させる前に、NFS を指定します。Supervivi のメニューの中で、機

能号[q]を選択して、次のコマンドを入力してください。 
Supervivi>param set linux_cmd_line "console=ttySAC0 root=/dev/nfs 
nfsroot=192.168.1.111:/root_nfs 
ip=192.168.1.70:192.168.1.111:192.168.1.111:255.255.255.0:MINI2440.arm9.net:et
h0:off"    (NFSの設定) 
 
Supervivi> boot ram   (メモリでカーネルを起動させます) 
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第九章 NOR Flash のブートロードを更新 
※ 一般的に NOR Flash のブートロードを更新することが必要ないです。 
 

9.1 簡易 JTAG で書き込み 

NOR Flash は H-JTAG というツールで更新されます。 
 
H-JTAG は ARM の為の JTAG エミュレータです。AXD 又は keil をサポートします。デバ

ッグのスピードも速いです。詳しい情報はこちらです。 
http://www.hjtag.com 
弊社は H-JTAG のハードウェアを提供しております。パソコンは LTP が必要です。 
 
9.1.1 H-JTAG をダウンロードとインストールします 
ホームページ http://www.hjtag.com から最新版をダウンロードできます。 
H-JTAG の特性： 
a. RDI 1.5.0 & 1.5.1 をサポートします; 
b. ARM7 & ARM9（ARM9E-S と ARM9EJ-S を含む）; 
c. thumb & arm 命令; 
d. little-endian & big-endian; 
e. semihosting; 
f. 実行環境 WINDOWS 9.X/NT/2000/XP; 
g. flash の書き込み 
 

 
弊社は H-JTAG のハードウェアを提供しております。パソコンは LTP が必要です。 
 
インストール完了すれば、デスクトップで H-JTAG と H-Flasher を生成します。H-JTAG
を実行すると、このエラーメッセージが出てきます。 

http://www.csun.co.jp/�
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設定しないから。"Ok"ボタンを押すと、初の画面が出てきます。 

 
 
H-JTAG のメニュー：Setting  Jtag Settings 
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この様な設定して、"Ok"ボタンを押します。 
 
H-JTAG のメニュー：Script  Init Script 

 
"Load"ボタンを押します。 
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FriendlyARM2440.his というファイルを選択します。 
 
次の画面が出てきます。 

 
"Ok"ボタンを押します。ご注意："Enable Auto Init"をチェックしない。 
 
パソコンと ARM9 ボードを H-JTAG で繋ぎます。ARM9 ボードの電源を入れます。 
H-JTAG のメニュー：Operations  Detect Target を選択すると 

http://www.csun.co.jp/�


 不可能への挑戦    不可能への挑戦   株式会社日昇テクノロジー        低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  134 

 
H-JTAG はターゲット ARM ボードを認識しました。 
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9.1.2 NOR Flash を書き込む 
※ ARM9 ボードが NOR Flash から起動することを確認してください。 
H-JTAG のメインメニュー「Flasher」「Start H-Flasher」で H-Flasher を実行し

ます。 

 

 
H-Flasherのメインメニュー「Load」、H-Flasher_mini2440.hfcというファイルを開

きます。 

 
 
H-Flasherの左側の「4 Programming」を選択します。 
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「Check」ボタンを押すと、mini2440が使用したNor Flash(AM29LV160DB)を発見

します。 

 

http://www.csun.co.jp/�


 不可能への挑戦    不可能への挑戦   株式会社日昇テクノロジー        低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  137 

「Type」の「Plain Binary Format」を選択します。 

 

書き込みのファイルsuperviviを選択します。「Dst Addr」で0を入力します。「Program」

ボタンを押すと、Nor Flashに書き込みます。 
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書き込み完了の画面： 
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9.2 Open-JTAG で書き込み 

 
弊社が販売している Open-JTAG は ARM 用

の USB-JTAG エミュレータです。ARM7、
ARM9 、 Cortex-M3, XSCALE に対応、

OpenOCD をサポートします。USB-RS232
機能もあります。COM と LPT ポートがない

ノートパソコンに最適。 
 
 
 
 

 
 

 

Opne-JTAGで書き込み様子 

http://www.csun.co.jp/�


 不可能への挑戦    不可能への挑戦   株式会社日昇テクノロジー        低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  140 

9.2.1 ドライバをインストールする 
※Windows 2000、ＸＰ用ドライバダウンロード URL： 

http://www.dragonwake.com/download/open-jtag/open-jtag-driver.zip 
※Windows7 用ドライバーダウンロード URL： 

http://www.dragonwake.com/download/open-jtag/open-jtag-driver_win7.zip 
「usb-drivers」フォルダーにある。 

OpenJTAG をパソコンの USB ポートに挿入して、下の通りにドライバをインストールし

てください。 
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USB ドライバのインストールは３回があります。インストール完了すると、デバイスマネ

ージャで三つのデバイスが見えます。 
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※ OpenJTAG は USB シリアルポートとして使えます。 
 

9.2.2 書き込み 
※書込みツールダウンロード URL： 
上記 USB ドライバダウンロード URL と同じ 

※Windows 2000、ＸＰ用ドライバダウンロード URL： 
http://www.dragonwake.com/download/open-jtag/open-jtag-driver.zip 

※Windows7 用ドライバーダウンロード URL： 
http://www.dragonwake.com/download/open-jtag/open-jtag-driver_win7.zip 
「tools」フォルダーにある。 

※ブートロードファイルダウンロード URL： 
http://www.dragonwake.com/download/arm9-download/linux-2.6.32.2/linux-images.tgz 
解凍後、色んな種類のボード用のブートロードファイルがありますが、ボードの種類によ

り、正しいファイルを選べてください。（ファイルの説明は中身の「Readme.txt」を参照） 
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C:¥openJTAG¥open-jtag>sjf24x0_ft2232.exe supervivi_mini2440 
+---------------------------------------------------------+ 

|     Flash Programmer for OpenJTAG of www.100ask.net     | 

|   OpenJTAG is a USB to JTAG & RS232 tool based FT2232   | 

|   This programmer supports both of S3C2410X & S3C2440   | 

|   Author: Email/MSN(thisway.diy@163.com), QQ(17653039)  | 

+---------------------------------------------------------+ 

Usage: sjf24x0_ft2232.exe [filename] 

Select the CPU: 

1. S3C2410X 

2. S3C2440X 

Enter the number: 2 

S3C24X0 detected, cpuID = 0x0032409d 

 

[Main Menu] 

 0:Nand Flash prog     1:Nor Flash prog   2:Memory Rd/Wr     3:Exit 

Select the function to test:1 

Detect Nor Flash ... 

SST 39VF1601 

Size: 2 MB 

 

Image Size: 0x1f314 

 

～略～ 

 

Erasing ................................ done 

write ... 

100%done 
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第十章 Web カメラストリーミング配信 

10.1 MJPG-streamerのダウンロードとコンパイル 

mjpg-streamerの最新バージョンをダウンロードします。 

$ svn co https://mjpg-streamer.svn.sourceforge.net/svnroot/mjpg-streamer 

mjpg-streamer 

 

$ cd mjpg-streamer/mjpg-streamer 

$ make CC=arm-linux-gcc 

成功すれば実行ファイルmjpg_streamerとライブラリ・ファイル*.soを生成します。 

 

10.2 MJPG-streamer を mini/micro2440 ボードにインストール 

生成されたファイル(mjpg_streamer、*.so)とmjpg-streamerのwwwディレクトリをmini/micro2440ボ

ードにダウンロードして、特定なディレクトリにをコピーしてください。 

# mkdir -p /usr/lib/ 

# cp *.so /usr/lib/ 

# cp mjpg_streamer /usr/bin/ 

# mv www /www/uvc-www 

 

 

弊社が販売している UVC(USB Device 

Class)に対応した Web カメラを

mini/micro2440 の USB ホストに接続して、

mini/micro2440 のコンソールで次のコマ

ンドで MJPG-streamer を起動させます。 

 

 

 

# mjpg_streamer --input "input_uvc.so --device /dev/video0 --fps 5 --resolution 

640x480 --yuv" --output "output_http.so --port 8080 --www /www/uvc-www" 

MJPG Streamer Version.: 2.0 

 i: Using V4L2 device.: /dev/video0 

 i: Desired Resolution: 640 x 480 

 i: Frames Per Second.: 5 
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 i: Format............: YUV 

 i: JPEG Quality......: 80 

 format asked unavailable get width 352 height 288 

 o: www-folder-path...: /www/uvc-www/ 

 o: HTTP TCP port.....: 8080 

 o: username:password.: disabled 

 o: commands..........: enabled 

 

※ UVC カメラによって、”--yuv”というパラメータは不要の可能性があるかもしれません 

※ UVC 以外のカメラは input_gspcav1.so を使います。 

 

10.3 Web ブラウザで Web カメラを見ましょう 

Web ブラウザで、「http://mini/micro2440 ボードの IP アドレス:8080/」にアクセスすると、

MJPG-Streamer Demo Pages が表示されます。静止画、動画、および Pan/Tilt/LED の On/Off

等の制御をすることができます。 (Internet Exploler 6 及び 7 では、MJPEG によるストリーム(動画)

を閲覧することができません。しかし、Javascript を使用したストリーム(動画)は、 Internet 

Explorer でも閲覧することができます。) 

 

Web ブラウザで見る様子： 
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第十一章 Eclipse + GCC + Open-JTAG 

11.1 GCC ツールチェーン 

各種ユーティリティ： 
http://www.yagarto.de/download/yagarto/yagarto-tools-20070303-setup.exe 
 
GCC ツールチェーン 
http://sourceforge.net/projects/yagarto/files/YAGARTO%20for%20Windows/yagarto-bu-
2.19.1_gcc-4.3.3-c-c%2B%2B_nl-1.17.0_gi-6.8.50_20090329.exe/download 
 
インストールが出来たら make の確認をするためコマンドプロンプトを起動し、右記のコ

マンドを入力します(make --version)。画面に下記のメッセージが出てくればＯＫです。 
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サンプルのコンパイル： 
1．コマンドプロンプトでディレクトリを移動 
     （cd¥leds) 
2．下記のコマンドを入力します 
     （make） 

 

コンパイル成功したら、*.bin ファイルを生成させます。 
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11.2 Integrated Development Environment(Eclipse) 
 
JRE バージョン確認： 
確認コマンド： java -version 

 

JRE がなければ、あるいは 1.4.2 以下なら、JRE のインストールが必要です。 
http://java.sun.com/javase/downloads/index.jsp 
 
 
Eclipse のインストール： 
１）下記のリンクをクリック 
http://www.eclipse.org/downloads/index.php 
 
２）Eclipse IDE for C/C++ Debelopers(79MB)の Windows をクリック 

http://www.csun.co.jp/�
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３）画面の下矢印をクリックしダウンロード 
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４）ダウンロードしたファイル "eclipse-cpp-galileo-win32.zip"を解凍し、そのなか

の”eclipse"フォルダを適当な場所(C:¥eclipse)へ移動する。 
 
5）Eclipse を起動する。 

 

 
６）最初に Workspace の場所を聞いてきます。適当なフォルダに変更してください。 
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画面の Workbench をクリックします。 
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11.3 プロジェクトを作る 

新規プロジェクトを作成するため"File"→"New"→"C Project"を選択します 

 

プロジェクト名を聞かれるので適当な名前(LED)を入力し Finish ボタンを押します。 
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Project Explorer にプロジェクト LED が追加されましたが中身が何もないので、"×"がつい

ています。 

 

サンプル LEDs.zip のなかのファイルを"C:¥workspace¥LED"にコピーしてください。 
 
Eclipse の”File"→"Refresh"を選択します。 
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Project Explorer の"LED"プロジェクトの左にある＋をクリックするとファイルの一覧が

表示されます。 

 
 

11.4 Eclipse プラグイン(Zylin Embedded CDT)インストール 

Eclipse の"Help"→"Install New Software"を選択します 
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Add ボタンを押します。 

 
Add Site の"Location"に"http://opensource.zylin.com/zylincdt "と入力し OK ボタンを押す。 
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Install に"http://opensource.zylin.com/zylincdt "が追加されるのでチェックボックスにク

リックしチェックを入れて Next ボタンを押す。 
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インストール完了したら、Yes ボタンを押して、Eclipse を再起動させます。 
 

11.5 ビルドの設定 

Eclipse の"Project"→"Preferences"を選択する。 
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Preferences の"Build"を選択し"Scanner Configuration Builder"のチェックマークを外し

て 
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Preferences の"C/C++ Build"→"Settings"を選択し"Binary Parsers"タブの"GNU Elf 
Parser"にチェックを入れて OK ボタンを押します 
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11.6 ビルド 

Eclipse の"Project"→"Build Automatically"のチックを外してください。 

 
 
 
"Project"→"Clean"を選択するクリアが行われます。 
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「Start a build immediately」のチェックマークを外して、「Ok」を押します。 
 
"Project"→"Build All"を選択するとビルドが行われます。 
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コンパイル中です。 

 
コンパイルが成功すれば、実行ファイル led_elf.elf と leds.bin を生成されます。 
 

11.7 GDB の設定 

Eclipse の"Run"→"Debug Configurations..."を選択します。 
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Debug Configurations の"Zylin Enbedded debug(Native)"を右クリックし"New"を選択す

る。 
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Name に適当な名前を入れる。例、"gdb"と入れます。Main タブの"Project"に"LED"、"C/C++ 
Appication:"に"C:¥workspace¥LED¥leds_elf"と入力します。 
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Debugger タブの"GDB debugger:"に"arm-elf-gdb"、"GDB command file:"に何も入力しま

せん。 
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Commands タブの"'Initialize' commands"に下記の画面の様に入力します 

target remote localhost:3333 

monitor halt   //ボードの実行を停止させる 

monitor arm920t cp15 2 0 // MMU機能をクローズ 

monitor step   //ステップで実行するように 

load    //leds_elfをロード 

break main   //「main」関数にブレークポイントを設定 

continue   //プログラムを実行させて、「main」にストップ 
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Common タブの"Display in favorites menu"の Debug にチェックを入れます。全てを入力

し終えたら"Apply"ボタンを押し、"Close"ボタンを押します。 
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11.8 OpenOCD の設定 

Eclipse の"Run"→"External Tools."→"External Tools Configrurations..."を選択します。 
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External Tools Configrurations の"Program"を右クリックし、"New"を選択します。 
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Main タブの"Name"に適当な名前を入力してください。私は”OpenOCD"と入れました。 
"Location:"に"C:¥Program Files¥OpenOCD¥0.1.0¥bin¥openocd.exe"、 
"Working Directory:"に"C:¥openJTAG"、 
"Arguments:"に-f "interface/open-jtag.cfg" -f "target/samsung_s3c2440.cfg" -c "arm7_9 
fast_memory_access enable"と入力します。 
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Build タブをクリックし"Build before launch"にチェックを外れます。 
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Common タブをクリックし"Display in favarites menu"の"External Tools"にチェックを入

れます。全てを入力し終えたら"Apply"ボタンを押し、"Close"ボタンを押します。 
 

11.9 デバッグ 

電源投入 
1. OpenJTAG をターゲット(MINI2440 ボード)とパソコンに接続 
2. ターゲットに電源を入れます 
 

http://www.csun.co.jp/�


 不可能への挑戦    不可能への挑戦   株式会社日昇テクノロジー        低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

 

ホームページ：http://www.csun.co.jp         メール：info@csun.co.jp  176 

External Tools の▼ボタンをクリックし、OpenOCD を選択 

 
Console ウインドに下記のメッセージが出力 

 
 
Debug の▼ボタンをクリックし、"gdb"を選択。 
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Yes ボタンを押して、デバッグが開始します。 
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Eclipse に Debug 用のコマンドあるいはショットカット一覧 
詳しくは Eclipse のドキュメントを参照 

 
 

ステップ実行において良く使われる操作の一覧を以下に示します。 

  

操作名 ショートカットキー 

再開 F8 

ステップイン F5 

ステップオーバー F6 

ステップ・リターン F7 

  

  

ステップ実行とは関係ありませんが、前回起動したクラスを再度実行したデバッグする場合は、

以下のショートカットキーが便利です。 

  

操作名 ショートカットキー 

前回の起動を実行 Ctrl + F11 

前回の起動をデバッグ F11 

 

ブレークポイントでプログラムが中断した状態から、次のブレークポイントまで実行させ

たり、1行ずつ実行させたりできます。コード「GPBDAT = (~(i<<5))」を繰り返して実行す

ることにより、LEDランプが１つずつ点滅 
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Debug 途中の ARM9 ボードの様子の１（一番右の LED ランプが点灯） 
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Debug 途中の ARM9 ボードの様子の２（右から 2 番目の LED ランプが点灯） 

 

 

11.10 デバッグ終了 

１）gdb の停止 
  Debug ウインドウの gdb の Thread を選択し、停止ボタンと押します 
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２）OpenOCD の停止 
  Debug ウインドウの OpenOCD の Thread を選択し、停止ボタンと押します 

 
３）電源停止 
  ターゲットの電源を停止 
 
４）OpenJTAG をターゲットから取り外す 
 
５）上記が面倒であれば Eclipse を終了しターゲットの電源停止、open-JTAG を取り外し

でも OK です。 
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